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1 Introduction 

A Comma-Separated Values (CSV), also called Comma Delimited, file is a specially formatted 
plain text file that stores information in a format that can be easily imported into a spreadsheet 
or database regardless of the file type.  

Downloadable CSV-formatted Remittance Advices (RA) allow users the benefits of building a 
customized RA specific to their use and the ability to save the file to their computer. A CSV file 
appears as linear text separated by commas until it is downloaded into a compatible software 
program. Once downloaded, the file may be saved and the data manipulated as desired. 

A CSV file may be downloaded into a Microsoft Office Excel spreadsheet or into another 
compatible software program, such as Microsoft Office Access or Apache OpenOffice. 
OpenOffice is a free software program obtainable from the Internet. Google Docs and ZDNet also 
offer free spreadsheet applications. 

Note: The examples in this user guide use Microsoft Office Excel 365. Earlier versions of 
Microsoft Office Excel will work with the CSV file; however, files exceeding 65,000 lines may 
need to be split into smaller files when downloading. If using another program, the user should 
consult the Help function of their specific program for instructions on how to import the file. 
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2 Download Remittance Advices in a 
Comma-Separated Values Report 
Format 

1. Access the ForwardHealth Portal at https://www.forwardhealth.wi.gov/.  

Figure 1  ForwardHealth Portal Homepage 

https://www.forwardhealth.wi.gov/
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2. Click Login. A Sign In box will be displayed. 

Figure 2  Sign In Box 

3. Enter the user’s username. 
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4. Click Next. A Verify with your password box will be displayed. 

Figure 3  Verify With Your Password Box 
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5. Enter the user’s password. 

6. Click Verify. The secure Provider page will be displayed. 

Figure 4  Secure Provider Page 
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7. Click Remittance Advices on the main menu at the top of the page. The Remittance Advices 
page will be displayed. 

The Remittance Advices option is displayed for administrative accounts or for clerk accounts 
that have been assigned the Remittance Advice role. For information about assigning clerk 
roles, refer to the ForwardHealth Provider Portal Account User Guide, which is located on the 
Portal User Guides page of the ForwardHealth Portal. 

Figure 5  Remittance Advices Page 

https://www.dhs.wisconsin.gov/publications/p0/p00952.pdf
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8. In the “Comma-Separated-Values Format (.csv)” section, click Download remittance advices 
in a CSV (.csv) report format. The Download RA page will be displayed. 

Figure 6  Download RA Page 

On the Download RA page, users can choose to download their 10 latest RAs.  

If there is a banner message(s) for an RA, users can click the button in the Banner Messages 
column to view the message(s).  

9. The user should click the row of the RA they wish to download. 

In the “Select an RA section to download” section, the All box is checked by default. When 
this option is checked, the entire RA will be downloaded.  
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10. To download specific sections of the RA, the user should uncheck the All box and select the 
sections of the RA they wish to download. 

Figure 7  Remittance Advices and Select an RA Section to Download Sections 

11. Click Submit. The File Download window will be displayed.  

Figure 8  File Download Window 
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12. Click Open. The CSV text file will be displayed in Excel. 

Figure 9  CSV Text File 

13. Certain columns may show scientific notations in place of long numbers such as internal 
control numbers (ICNs). To correct this: 

a. Click a column header to highlight the column. 
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b. Under the Home menu item, click the Number Format dialog box (represented by a 
diagonal arrow in the corner). 

Figure 10  CSV Text File Number Fix 
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c. Select Custom in the Category section. 

Figure 11  Number Format Dialog Box 

d. Select # ?/? in the Type section. 

e. Click OK. Once expanded, all columns with long numbers should now appear correctly. 
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Note: The user must first save the CSV text file to properly download and format the data 
content as a spreadsheet document. 

Figure 12  Save As Window 

14. Choose a location on the computer or network to save the RA CSV text file. 

15. Click Save.  

2.1 Format the Comma-Separated Values File 

To properly read the CSV text file after it has been saved, the user will need to first import the 
text file into a spreadsheet or database program and then format it. The examples shown here 
use the Excel spreadsheet program. 

1. Open a blank spreadsheet. 
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2. In the menu bar at the top of the screen, click Data. The Data menu will be displayed. 

Figure 13  Blank Spreadsheet  

3. Click From Text/CSV located on the left side of the Data menu. The Import Data window will 
open.  

Figure 14  Import Data Window 

4. Navigate to the location where the user saved the CSV file and select the file. 
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5. Click Import. The data capture window will be displayed. 

Figure 15  Data Capture Window  

6. Keep the default File Origin, Delimiter, and Data Type Detection values, as shown.  
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7. Click Load. The final imported file will be displayed. 

Figure 16  Final Imported RA File 

8. Save the formatted file. Saving before making changes will help to avoid having to convert 
the CSV file again should the user encounter problems while working with the data.   

2.2 Reading the Imported File 

Note: References to row numbers and column letters pertain to the examples used in this user 
guide. Actual rows and columns will differ for each downloaded RA file. 

Once the CSV file is imported into Excel, the information will be easier to read and understand. 
The first column (column A) of the imported data displays the RA number. 

The RA is divided into sections, with each section containing a number that represents a specific 
area within the RA. The second column (column B) displays the section number for the specific 
sections of the RA the user chose to download.  
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2.2.1 Section 010—Payment Information 

Section 010 contains payment information such as the check or electronic funds transfer (EFT) 
trace number, the payment date, the provider’s National Provider Identifier. 

Figure 17  Section 010 

The top row of each section contains the field labels for that section. The field label row indicates 
what data is included in each column. For example, in section 010, the field label for row 1 shows 
that column C contains the Check/EFT Number. In row 2, the actual check or EFT number will be 
displayed. 



March 11, 2024 ForwardHealth Provider Portal Comma-Separated Values Remittance Advice User Guide 
 

 
2 Download Remittance Advices in a Comma-Separated 

Values Report Format   17 
 

2.2.2 Section 020—Payment Hold Information 

Some sections may contain more than one row of field labels as seen in section 020. 

Figure 18  Section 020  

Section 020 contains information about any payment holds issued for that RA period. The two 
field label rows displayed for this section (rows 3 and 4 in the example above) indicate that there 
are two lines of information for each payment held. 

Example: The example above contains two payment holds: Reference #212134638 and 
Reference #232246587. There are two lines of information for each hold. 

The first line of each payment hold (rows 5 and 7) displays the Total Amount Held (column D) 
and the Hold Reason (column E). 

The second line of each hold (rows 6 and 8) displays the Transaction Type (column D), the Hold 
Reason, (column E), and the Amount Held (column F): 

• The Total Amount Held represents the total amount withheld from this particular payment. 

• The Amount Held represents the particular claim or transaction amount that was withheld 
within the total payment amount. 

Example: A total payment hold could be $100. Within that payment hold, there could be four 
separate claims/transactions held, each with an amount held of $25. All the transactions added 
together will add up to the total amount held. 
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2.2.3 Section 030—Service Codes and Descriptions 

Section 030 contains the service code and description for the service code(s) covered in the RA. 

Figure 19  Section 030 

2.2.4 Sections 040—120 

Note: For the claims sections of the RA spreadsheet, it is helpful to split the window and freeze 
the panes in the spreadsheet so that the user can retain the field labels in place while they scroll 
through the claim detail. For information about splitting a window and freezing panes, refer to 
Chapter 3 Split Window and Freeze Panes. 

Sections 040–120 contain information about the individual claims. The section numbers describe 
the type of claim for which the information is displayed in the RA. The following is a list of section 
numbers and their corresponding claim types: 

• 040 Inpatient Claims 

• 050 Outpatient Claims 

• 060 Professional Service Claims 

• 070 Medicare Crossover—Professional Service Claims 

• 080 Medicare Crossover—Institutional Claims 
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• 090 Compound Drug Claims 

• 100 Drug Claims 

• 110 Dental Claims 

• 120 Long-Term Care Claims 

Each section will first list three rows of field labels that providers are to use to interpret the data 
that follows:  

Figure 20  Claim Section Field Labels 

• Top row: Non-adjusted Claim/Adjustments—The top row contains field labels for the 
standard header information from a non-adjusted claim or an adjusted claim.  

• Middle row: Adjusted Claim—The middle row contains field labels for the header information 
from a claim that is being adjusted (adjusted claim), when applicable. The header 
information displayed will be taken from the original claim before the adjustment changes 
are made. If there has been no adjustment, there will be no middle row. 

• Bottom row: Claim Details—The bottom row contains field labels for the claim details for 
non-adjusted claims and adjustments (the top row). There can be anywhere from 1–999 
claim details listed. Details will not be displayed for an adjusted claim (the middle row). 

To determine which row(s) of field headers to use, refer to the Claim Status column (column D): 

• For claims with a claim status of P (paid), D (denied), or S (in progress), use the top row of 
field labels for header information and the bottom row for the claim’s detail information.  

These claims will always have an N (non-adjusted) in the Adjustment Indicator column. 
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• For claims with a claim status of A (Adjusted), refer to the Adjustment Indicator column to 
determine which row of field labels to use. 

o Y (adjustment)—Use the top row of field labels for the adjusted claim’s header 
information and the bottom row for its detail information. 

o M (adjusted claim)—Use the middle row of field labels for the adjusted claim’s header 
information. There are no claim details displayed for adjusted claims.         
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Example of a Paid Claim 

The following example shows information for a paid claim (claim status of P). 

Figure 21  Example of a Paid Claim 

The row containing Detail #0 (row 9; highlighted in green) is the header information for the 
claim. Use the top row of field labels (row 6; highlighted in green) to read the header 
information for the claim. 

The middle row of field labels (highlighted in blue) is not used because this is a non-adjusted 
claim. (Refer to the Adjustment Indicator column [column L].) 

The rows containing Detail# 1–2 (rows 10 and 11; highlighted in gray) are the details for the 
claim. Use the third row of field labels (row 8; highlighted in gray) to read the detail information. 

Example: The Billed Amt (Amount) (column O) for the entire claim is $200.00 (row 9; highlighted 
in green). The billed amount for Detail 1 is $100.00 (row 10; highlighted in gray). The billed 
amount for Detail 2 is $100.00 (row 11; highlighted in gray). 
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Example of a Claim Adjustment 

The following example shows information for a claim adjustment (claim status of A). 

Figure 22  Example of a Claim Adjustment  

The row containing Detail # 0 and Adjustment Indicator Y (row 6; highlighted in light blue) is the 
header information for the claim adjustment. Use the top row of field labels (row 3; highlighted 
in blue) to read the header information for the adjusted claim. 

The row containing Detail # 0 and Adjustment Indicator M (row 7; highlighted in green) refers to 
the original claim to which the adjustment was made. Use the middle row of field labels (row 4; 
highlighted in green) to read the information about the original claim. No detail information is 
shown for the original claim. 

The row containing Detail # 1 and Adjustment Indicator Y (row 8; highlighted in purple) is the 
detail information for the adjusted claim. Use the bottom row of field labels (row 5; highlighted 
in purple) to read the detail information for the adjusted claim.  

Example: The From DOS (Date of Service) (column M) for the adjusted claim (row 6; highlighted 
in light blue) is 03/22/2022.  

The Previous ICN (column M) for the original claim (row 7; highlighted in green) is 2.222E+12. 

The Proc (procedure) Code (column N) for Detail 1 of the adjusted claim (row 8; highlighted in 
purple) is 90747. 
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Field Labels 

Field labels vary depending on claim type, header or detail information, and claim status (paid, 
denied, adjusted). The following tables display all the fields that could be populated for each 
claim type. Not every field will be populated for every claim. 

Section 040—Inpatient Claims 

Inpatient Claims 
Denied Paid 

Header Detail Header Detail 

RA # RA# RA # RA# 

040-01 040-01 040-01 040-01 

ICN ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status Claim Status 

Detail # Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name Member First Name 

Member No Member No Member No Member No 

PCN PCN PCN PCN 

MRN MRN MRN MRN 

Adjustment Indicator Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Rev Code From DOS Rev Code 

To DOS From DOS To DOS From DOS 

Covered Days To DOS Covered Days To DOS 

Admit Date Allowed Units Admit Date Allowed Units 

Billed Amt PA Number Billed Amt PA Number 

Other Ins Amt Billed Amt Allowed Amt Billed Amt 

Spenddown Amt Detail EOBS Incentives Allowed Amt 

Outlier Amt  Other Ins Amt Incentives 

DRG Code  Spenddown Amt Paid Amt 

SOI  Copay Amt Detail EOBS 

Surgical  Co-Ins CB  

Diagnosis  Outlier Amt  

Header EOBS  Inpat Ded  

  Paid Amt  

  DRG code  

  SOI  

  Surgical  

  Diagnosis  
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Inpatient Claims 
Denied Paid 

Header Detail Header Detail 

  Header EOBS  
 

Inpatient Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

RA # RA # RA # 

040-01 040-01 040-01 

ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status 

Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name 

Member No Member No Member No 

PCN PCN PCN 

MRN MRN MRN 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Previous ICN  Rev Code 

To DOS Previous ICN Seq From DOS 

Covered Days From DOS To DOS 

Admit Date To DOS Allowed Units 

Billed Amt Covered Days PA Number 

Allowed Amt Admit Date Billed Amt 

Incentives Billed Amt Allowed Amt 

Other Ins Amt Allowed Amt Incentives 

Spenddown Amt Incentives Paid Amt 

Copay Amt Other Ins Amt Detail EOBS 

Co-Ins CB Spenddown Amt Net Payment Adjustment 

Outlier Amt Copay Amt  

DRG Code Co-Ins CB  

SOI Outlier Amt  

Inpat Ded DRG Code   

Paid Amt SOI  

Surgical Inpat Ded  

 Paid Amt  

Diagnosis Surgical  
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Inpatient Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

 Diagnosis  

 Additional Payment  

 Overpayment To Be Withheld  

 Refund Amount Applied  

 Adjustment EOB  

Section 050—Outpatient Claims 

Outpatient Claims 
In Process Denied Paid 

Header Detail Header Detail Header Detail 

RA # RA # RA # RA # RA # RA # 

050-01 050-01 050-01 050-01 050-01 050-01 

ICN ICN ICN ICN ICN ICN 

Adjustment ICN 

Seq 

Adjustment ICN 

Seq 

Adjustment ICN 

Seq 

Adjustment ICN 

Seq 

Adjustment 

ICN Seq 

Adjustment 

ICN Seq 

Claim Status Claim Status Claim Status Claim Status Claim Status Claim Status 

Detail # Detail # Detail # Detail # Detail # Detail # 

Member Last 

Name 

Member Last 

Name 

Member Last 

Name 

Member Last 

Name 

Member 

Last Name 

Member 

Last Name 

Member First 

Name 

Member First 

Name 

Member First 

Name 

Member First 

Name 

Member 

First Name 

Member 

First Name 

Member No Member No Member No Member No Member No Member No 

PCN PCN PCN PCN PCN PCN 

MRN MRN MRN MRN MRN MRN 

Adjustment 

Indicator 

Adjustment 

Indicator 

Adjustment 

Indicator 

Adjustment 

Indicator 

Adjustment 

Indicator 

Adjustment 

Indicator 

From DOS Proc Code From DOS Rev Code From DOS Rev Code 

To DOS Modifiers To DOS Proc Code To DOS Proc Code 

Billed Amt Service Date Billed Amt Modifiers Billed Amt Modifiers 

Other Ins Amt Allowed Units Allowed Amt Service Date Allowed Amt Service Date 

Header EOBS Rendering 

Provider ID Type 

Other Ins Amt Allowed Units Incentives Allowed 

Units 

 Rendering 

Provider ID 

Spenddown 

Amt 

PA Number Other Ins 

Amt 

PA Number 

 Billed Amt Copay Amt Billed Amt Spenddown 

Amt 

Billed Amt 
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Outpatient Claims 
In Process Denied Paid 

Header Detail Header Detail Header Detail 

 Detail EOBS Co-Ins CB Detail EOBS Copay Amt Allowed 

Amt 

  Outpat Ded  Co-Ins CB Incentives 

  Paid Amt  Outpat Ded Copay Amt 

  Header EOBS  Paid Amt Paid Amt 

    Header 

EOBS 

Detail EOBS 

 

Outpatient Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

RA # RA # RA # 

050-01 050-01 050-01 

ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status 

Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name 

Member No Member No Member No 

PCN PCN PCN 

MRN MRN MRN 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Previous ICN Rev Code 

To DOS Previous ICN Seq Proc Code 

Billed Amt From DOS Modifiers 

Allowed Amt To DOS Service Date 

Incentives Billed Amt Allowed Units 

Other Ins Amt Allowed Amt PA Number 

Spenddown Amt Incentives Billed Amt 

Copay Amt Other Ins Amt Allowed Amt 

Co-Ins CB Spenddown Amt Incentives 

Outpat Ded Copay Amt Copay Amt 

Paid Amt Co-Ins CB Paid Amt 

 Outpat Ded Detail EOBS 

 Paid Amt Net Payment Adjustment 
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Outpatient Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

 Additional Payment  

 Overpayment To Be Withheld  

 Refund Amount Applied  

 Adjustment EOB  

Section 060—Professional Service Claims 

Professional Service Claims 
In Process Denied Paid 

Header Detail Header Detail Header Detail 

RA# RA# RA# RA# RA# RA# 

060-01 060-01 060-01 060-01 060-01 060-01 

ICN ICN ICN ICN ICN ICN 

Adjustment 

ICN Seq 

Adjustment ICN 

Seq 

Adjustment ICN 

Seq 

Adjustment 

ICN Seq 

Adjustment 

ICN Seq 

Adjustment 

ICN Seq 

Claim Status Claim Status Claim Status Claim Status Claim Status Claim Status 

Detail # Detail # Detail # Detail # Detail # Detail # 

Member Last 

Name 

Member Last 

Name 

Member Last 

Name 

Member Last 

Name 

Member Last 

Name 

Member Last 

Name 

Member First 

Name 

Member First 

Name 

Member First 

Name 

Member First 

Name 

Member 

First Name 

Member First 

Name 

Member No Member No Member No Member No Member No Member No 

PCN PCN PCN PCN PCN PCN 

MRN MRN MRN MRN MRN MRN 

Adjustment 

Indicator 

Adjustment 

Indicator 

Adjustment 

Indicator 

Adjustment 

Indicator 

Adjustment 

Indicator 

Adjustment 

Indicator 

From DOS Proc Code From DOS Proc Code From DOS Proc Code 

To DOS Modifiers To DOS Modifiers To DOS Modifiers 

Billed Amt From DOS Billed Amt From DOS Billed Amt From DOS 

Other Ins Amt To DOS Other Ins Amt To DOS Allowed Amt To DOS 

Header EOBS Allowed Units Spenddown 

Amt 

Allowed Units Incentives Allowed Units 

 Rendering 

Provider ID 

Type 

Header EOBS Rendering 

Provider ID 

Type 

Other Ins 

Amt 

Rendering 

Provider ID 

Type 

 Rendering 

Provider ID 

 Rendering 

Provider ID 

Spenddown 

Amt 

Rendering 

Provider ID 

 Billed Amt  PA Number Copay Amt PA Number 



March 11, 2024 ForwardHealth Provider Portal Comma-Separated Values Remittance Advice User Guide 
 

 
2 Download Remittance Advices in a Comma-Separated 

Values Report Format   28 
 

Professional Service Claims 
In Process Denied Paid 

Header Detail Header Detail Header Detail 

 Detail EOBS  Billed Amt Co-Ins CB Billed Amt 

   Detail EOBS Outpat Ded Copay Amt 

    Paid Amt Allowed Amt 

    Header EOBS Incentives 

     Paid Amt 

     Detail EOBS 
 

Professional Service Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

RA# RA# RA# 

060-01 060-01 060-01 

ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status 

Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name 

Member No Member No Member No 

PCN PCN PCN 

MRN MRN MRN 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Previous ICN Proc Code 

To DOS Previous ICN Seq Modifiers 

Billed Amt From DOS From DOS 

Allowed Amt To DOS To DOS 

Incentives Billed Amt Allowed Units 

Other Ins Amt Allowed Amt Rendering Provider ID Type 

Spenddown Amt Incentives Rendering Provider ID 

Copay Amt Other Ins Amt PA Number 

Co-Ins CB Spenddown Amt Billed Amt 

Outpat Ded Copay Amt Copay Amt 

Paid Amt Co-Ins CB Allowed Amt 

 Outpat Ded Incentives 

 Paid Amt Paid Amt 

 Additional Payment Detail EOBS 
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Professional Service Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

 Overpayment To Be Withheld Net Payment Adjustment 

 Refund Amount Applied  

 Adjustment EOB  
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Section 070—Medicare Crossover—Professional Service Claims 

Medicare Crossover—Professional Claims 
Denied Paid 

Header Detail Header Detail 

RA# RA# RA# RA# 

070-01 070-01 070-01 070-01 

ICN ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Detail # Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name Member First Name 

Member No Member No Member No Member No 

PCN PCN PCN PCN 

MRN MRN MRN MRN 

Adjustment 

Indicator 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Rev Code From DOS Rev Code 

To DOS Proc Code To DOS Proc Code 

Billed Amt Modifiers Billed Amt Modifiers 

Other Ins Amt From DOS Incentives From DOS 

Spenddown To DOS Other Ins Amt To DOS 

Copay Amt Allowed Units Spenddown Allowed Units 

Medicare Copay Rendering Provider ID 

Type 

Copay Amt Rendering Provider ID Type 

Medicare Co-Ins Rendering Provider ID Co-Ins CB Rendering Provider ID 

Medicare Deduct PA Number Outpat Ded PA Number 

Medicare Allowed Billed Amt Paid Amt Billed Amt 

Medicare Psych Co-

Ins 

Spenddown Medicare Copay Incentives 

Medicare Paid Amt Detail EOBS Medicare Co-Ins Spenddown 

Header EOBS  Medicare Deduct Allowed Amt 

  Medicare Allowed Copay Amt 

  Medicare Psych Co-

Ins 

Paid Amt 

  Medicare Paid Amt Detail EOBS 

  Header EOBS  
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Medicare Crossover—Professional Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

RA# RA# RA# 

070-01 070-01 070-01 

ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status 

Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name 

Member No Member No Member No 

PCN PCN PCN 

MRN MRN MRN 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Previous ICN Rev Code 

To DOS Previous ICN Seq Proc Code 

Billed Amt From DOS Modifiers 

Incentives To DOS From DOS 

Other Ins Amt Billed Amt To DOS 

Spenddown Incentives Allowed Units 

Copay Amt Other Ins Amt Rendering Provider ID Type 

Co-Ins CB Spenddown Rendering Provider ID 

Outpat Ded Copay Amt PA Number 

Paid Amt Co-Ins CB Billed Amt 

Medicare Copay Outpat Ded Incentives 

Medicare Co-Ins Paid Amt Spenddown 

Medicare Deduct Medicare Copay Allowed Amt 

Medicare Allowed Medicare Co-Ins Copay Amt 

Medicare Psych Co-Ins Medicare Deduct Paid Amt 

Medicare Paid Amt Medicare Allowed Detail EOBS 

 Medicare Psych Co-Ins Net Payment Adjustment 

 Medicare Paid Amt  

 Additional Payment  

 Overpayment To Be Withheld  

 Refund Amount Applied  
 Adjustment EOB  
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Section 080—Medicare Crossover—Institutional Claims 

Medicare Crossover—Institutional Claims 
Denied Paid 

Header Detail Header Detail 

RA# RA# RA# RA# 

080-01 080-01 080-01 080-01 

ICN ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status Claim Status 

Detail # Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name Member First Name 

Member No Member No Member No Member No 

PCN PCN PCN PCN 

MRN MRN MRN MRN 

Adjustment Indicator Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Rev Code From DOS Rev Code 

To DOS Proc Code To DOS Proc Code 

Admit Date Modifiers Admit Date Modifiers 

Days  From DOS Days From DOS 

Billed Amt To DOS Billed Amt To DOS 

Other Ins Amt  Incentives Allowed Units 

Spenddown Allowed Units Other Ins Amt Rendering Provider ID 

Type 

Copay Amt Rendering Provider ID 

Type 

Spenddown Rendering Provider ID 

Patient Liab Rendering Provider ID Copay Amt PA Number 

Medicare Copay PA Number Co-Ins CB Billed Amt 

Medicare Co-Ins Billed Amt Patient Liab Allowed Amt 

Medicare Deduct Spenddown Inpat/Outpat Deduct Incentives 

Medicare Blood 

Deduct 

 Paid Amt Spenddown 

Medicare Paid Amt  Medicare Copay Copay Amt 

Header EOBS  Medicare Co-Ins Paid Amt 

  Medicare Deduct Detail EOBS 

  Medicare Blood 

Deduct 

 

  Medicare Paid Amt  

  Header EOBS  
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Medicare Crossover—Institutional Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

RA# RA# RA# 

080-01 080-01 080-01 

ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status 

Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name 

Member No Member No Member No 

PCN PCN PCN 

MRN MRN MRN 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Previous ICN Rev Code 

Admit Date Previous ICN Seq Modifiers 

Days To DOS From DOS 

Billed Amt Admit Date To DOS 

Incentives Days Allowed Units 

Other Ins Amt Billed Amt Rendering Provider ID Type 

Spenddown Incentives Rendering Provider ID 

Copay Amt Other Ins Amt PA Number 

Co-Ins CB Spenddown Billed Amt 

Patient Liab Copay Amt Allowed Amt 

Inpat/Outpat Deduct Co-Ins CB Incentives 

Paid Amt Patient Liab Spenddown 

Medicare Copay Inpat/Outpat Deduct Copay Amt 

Medicare Co-Ins Paid Amt Paid Amt 

Medicare Deduct Medicare Copay Detail EOBS 

Medicare Blood Deduct Medicare Co-Ins Net Payment Adjustment 

Medicare Paid Amt Medicare Deduct  

 Medicare Blood Deduct  

 Medicare Paid Amt  

 Additional Payment  

 Overpayment To Be Withheld  

 Refund Amount Applied  

 Adjustment EOB  
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Section 090—Compound Drug Claims 

Compound Drug Claims 
Denied Paid 

Header Detail Header Detail 

RA# RA# RA# RA# 

090-01 090-01 090-01 090-01 

ICN ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status Claim Status 

Detail # Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name Member First Name 

Member No Member No Member No Member No 

Rx Number Rx Number Rx Number Rx Number 

Adjustment Indicator Adjustment Indicator Adjustment Indicator Adjustment Indicator 

Prescribing Provider ID 

Type 

National Drug Code 

(NDC) 

Prescribing Provider ID 

Type 

National Drug Code 

(NDC) 

Prescribing Provider ID NDC Description Prescribing Provider ID NDC Description 

Unit Dose (UD) Metric Qty Unit Dose (UD) Metric Qty 

Dispense As Written 

(DAW) 

PA Number Dispense As Written 

(DAW) 

PA Number 

Submission Clarification 

Code (SUB) 

Billed Amt Submission Clarification 

Code (SUB) 

Billed Amt 

  Level of Effort (LVL Eff) Incentives 

Level of Effort (LVL Eff) Detail EOBS Service Date Allowed Amt 

Service Date  Quantity Paid Amt 

Quantity  Billed Amt Detail EOBS 

Billed Amt  Incentives  

Other Ins Amt  Other Ins Amt  

Spenddown  Spenddown  

Header EOBS  Copay Amt  

  Ingredient Allow Amt  

  Dispensing Fee (Disp 

Allowed) 

 

  Deductible Amt  

  Paid Amt  

  Header EOBS  
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Compound Drug Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

RA# RA# RA# 

090-01 090-01 090-01 

ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status 

Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name 

Member No Member No Member No 

Rx Number Rx Number Rx Number 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

Prescribing Provider ID Type Previous ICN National Drug Code (NDC) 

Prescribing Provider ID Previous ICN Seq NDC Description 

Unit Dose (UD) Prescribing Provider ID Type Metric Qty 

Dispense As Written (DAW) Prescribing Provider ID PA Number 

Submission Clarification Code 

(SUB) 

Unit Dose (UD) Billed Amt 

Level of Effort (LVL Eff) Dispense As Written (DAW) Incentives 

Service Date Submission Clarification Code 

(SUB) 

Allowed Amt 

Quantity Level of Effort (LVL Eff) Paid Amt 

Billed Amt Service Date Detail EOBS 

Incentives Quantity Net Payment Adjustment 

Other Ins Amt Billed Amt  

Spenddown Incentives  

Copay Amt Other Ins Amt  

Ingredient Allow Amt Spenddown  

Dispensing Fee (Disp Allowed) Copay Amt  

Deductible Amt Ingredient Allow Amt  

Paid Amt Dispensing Fee (Disp Allowed)  

 Deductible Amt  

 Paid Amt  

 Additional Payment  

 Overpayment To Be Withheld  

 Refund Amount Applied  

 Adjustment EOB  
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Section 100—Drug Claims 

Drug Claims 
Denied Paid 

Header Detail Header Detail 

RA# RA# RA# RA# 

100-01 100-01 100-01 100-01 

ICN ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status Claim Status 

Detail # Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name Member First Name 

Member No Member No Member No Member No 

Rx Number Rx Number Rx Number Rx Number 

Adjustment Indicator Adjustment Indicator Adjustment Indicator Adjustment Indicator 

Prescribing Provider ID 

Type 

Detail EOBS Prescribing Provider ID 

Type 

Detail EOBS 

Prescribing Provider ID  Prescribing Provider ID  

National Drug Code 

(NDC) 

 National Drug Code 

(NDC) 

 

NDC Description  NDC Description  

Service Date  Service Date  

Unit Dose (UD)  Unit Dose (UD)  

Dispense As Written 

(DAW) 

 Dispense As Written 

(DAW) 

 

Submission Clarification 

Code (SUB) 

 Submission Clarification 

Code (SUB) 

 

Quantity  Quantity  

PA Number  PA Number  

Billed Amt  Billed Amt  

Other Ins Amt  Incentives  

Spenddown  Other Ins Amt  

Dur Reject  Spenddown  

Header EOBS  Copay Amt  

  Co-Ins CB  

  Ingredient Allow Amt  

  Dispensing Fee (Disp 

Allow) 

 

  Deductible  
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Drug Claims 
Denied Paid 

Header Detail Header Detail 

  Paid Amt  

  Dur Reject  

  Header EOBS  
 

Drug Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

RA# RA# RA# 

100-01 100-01 100-01 

ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status 

Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name 

Member No Member No Member No 

Rx Number Rx Number Rx Number 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

Prescribing Provider ID Type Previous ICN Detail EOBS 

Prescribing Provider ID Previous ICN Seq Net Payment Adjustment 

National Drug Code (NDC) Prescribing Provider ID Type  

NDC Description Prescribing Provider ID  

Service Date National Drug Code (NDC)  

Unit Dose (UD) NDC Description  

Dispense As Written (DAW) Service Date  

Submission Clarification Code 

(SUB) 

Unit Dose (UD)  

Quantity Dispense As Written (DAW)  

PA Number Submission Clarification Code 

(SUB) 

 

Billed Amt Quantity  

Incentives PA Number  

Other Ins Amt Billed Amt  

Spenddown Incentives  

Copay Amt Other Ins Amt  

Co-Ins CB Spenddown  
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Drug Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

Ingredient Allow Amt Copay Amt  

Dispensing Fee (Disp Allow) Co-Ins CB  

Deductible Ingredient Allow Amt  

Paid Amt Dispensing Fee (Disp Allow)  

 Deductible  

 Paid Amt  

 Additional Payment  

 Overpayment To Be Withheld  

 Refund Amount Applied  

 Adjustment EOB  

Section 110—Dental Claims 

Dental Claims 
Denied Paid 

Header Detail Header Detail 

RA# RA# RA# RA# 

110-01 110-01 110-01 110-01 

ICN ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status Claim Status 

Detail # Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name Member First Name 

Member No Member No Member No Member No 

Adjustment Indicator Adjustment Indicator Adjustment Indicator Adjustment Indicator 

Rendering Provider ID 

Type 

Proc Code Rendering Provider ID 

Type 

Proc Code 

Rendering Provider ID Tooth Rendering Provider ID Tooth 

From DOS Surface From DOS Surface 

To DOS Area of Oral Cavity To DOS Area of Oral Cavity 

Billed Amt Service Date Billed Amt Service Date 

Other Ins Amt  PA Number Allowed Amt  PA Number 

Spenddown Amt Billed Amt Incentives Billed Amt 

Header EOBS Detail EOBS Other Ins Amt Allowed Amt 

  Spenddown Amt Incentives 

  Copay Amt Copay Amt 

  Co-Ins CB Paid Amt 
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Dental Claims 
Denied Paid 

Header Detail Header Detail 

  Paid Amt Detail EOBS 

  Header EOBS  
 

Dental Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

RA# RA# RA# 

110-01 110-01 110-01 

ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Claim Status Claim Status Claim Status 

Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name 

Member No Member No Member No 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

Rendering Provider ID Type Previous ICN Proc Code 

Rendering Provider ID Previous ICN Seq Tooth 

From DOS Rendering Provider ID Type Surface 

To DOS Rendering Provider ID Area of Oral Cavity 

Billed Amt From DOS Service Date 

Allowed Amt To DOS PA Number 

Incentives Billed Amt Billed Amt 

Other Ins Amt Allowed Amt Allowed Amt 

Spenddown Amt Incentives Incentives 

Copay Amt Other Ins Amt Copay Amt 

Co-Ins CB Spenddown Amt Paid Amt 

Paid Amt Copay Amt Detail EOBS 

 Co-Ins CB Net Payment Adjustment 

 Paid Amt  

 Additional Payment  

 Overpayment To Be Withheld  

 Refund Amount Applied  

 Adjustment EOB  

 Header EOBS  
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Section 120—Long-Term Care Claims 

Long-Term Care Claims 
Denied Paid 

Header Detail Header Detail 

RA# RA# RA# RA# 

120-01 120-01 120-01 120-01 

ICN ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Detail # Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name Member First Name 

Member No Member No Member No Member No 

PCN PCN PCN PCN 

MRN MRN MRN MRN 

Adjustment Indicator Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Rev Code From DOS Rev Code 

To DOS Proc Code To DOS Proc Code 

Days From DOS Days From DOS 

Condition Code To DOS Condition Code To DOS 

Billed Amt Allowed Units Billed Amt Allowed Units 

Other Ins Amt PA Number Allowed Amt PA Number 

Header EOBS Billed Amt Incentives Billed Amt 

 Detail EOBS Other Ins Amt Allowed Amt 

  Patient Liab Incentives 

  Paid Amt Paid Amt 

  Header EOBS Detail EOBS 
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Long-Term Care Claims 
Adjustments 

Adjustment Original Claim Adjustment Details 

RA# RA# RA# 

120-01 120-01 120-01 

ICN ICN ICN 

Adjustment ICN Seq Adjustment ICN Seq Adjustment ICN Seq 

Detail # Detail # Detail # 

Member Last Name Member Last Name Member Last Name 

Member First Name Member First Name Member First Name 

Member No Member No Member No 

PCN PCN PCN 

MRN MRN MRN 

Adjustment Indicator Adjustment Indicator Adjustment Indicator 

From DOS Previous ICN Rev Code 

To DOS Previous ICN Seq Proc Code 

Days From DOS From DOS 

Condition Code To DOS To DOS 

Billed Amt Days Allowed Units 

Allowed Amt Condition Code PA Number 

Incentives Billed Amt Billed Amt 

Other Ins Amt Allowed Amt Allowed Amt 

Patient Liab Incentives Incentives 

Paid Amt Other Ins Amt Paid Amt 

 Patient Liab Detail EOBS 

 Paid Amt Net Payment Adjustment 

 Additional Payment  

 Overpayment To Be Withheld  

 Refund Amount Applied  

 Adjustment EOB  

 Header EOBS  

2.2.5 Sections 130–220 

Sections 130–220 contain the following information: 

• 130 Financial Transactions—Non-Claim Specific Payouts to Payee 

• 140 Financial Transactions—Non-Claim Specific Refunds From Payee 

• 150 Financial Transactions—Accounts Receivable 
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• 160 Summary—Net Payments 

• 170 Summary—Claims Data 

• 180 Summary—Earnings Data Payments 

• 190 Summary—Earnings Data Refunds 

• 200 Summary—Earnings Data Other Financial 

• 210 Summary—Outstanding Checks 

• 220 Summary—Payments to Lien Holders 

Figure 23  Example of Sections 130–220
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3 Split Window and Freeze Panes 

The example below shows that the field labels (rows 6–8) for Section 050 would scroll off the top 
of the screen if the user was to scroll down to view more claims. To avoid this, the user can 
freeze the field labels in place so that they can retain them at the top of the screen when viewing 
the claims in that section.  

Figure 24  Example of Field Labels to Be Frozen 

1. In the menu bar at the top of the screen, click View. The View menu will be displayed. 

Figure 25  View Menu 
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2. Click the Split icon located in the Window section of the menu. A horizontal and vertical line 
will appear on the spreadsheet. 

Figure 26  Split Window Lines 
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3. Click and drag the lines to where the user wants to split the screen into individual panes.  

In the example below, the horizontal line has been dragged to the bottom row of field labels. 

Figure 27  Drag Split Window Lines 

The user can drag the vertical line to split columns, or they can drag the vertical line to the 
right of the screen to remove the line from the screen.  
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4. On the View menu, click Freeze Panes. The Freeze Panes drop-down menu will be displayed. 

Figure 28  Freeze Panes Drop-Down Menu 

5. Select Freeze Panes from the drop-down menu. The gray split window horizontal line will 
change to a small black line. The rows above the line will “freeze” in place while the user 
scrolls through the rows below. 
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In the example below, rows 6–8 will stay at the top of the window while the user scrolls 
through the rows below row 8. 

Figure 29  Example of a Frozen Pane 

 


